
Guide 31 
Version 1.0 

Putting equations into a 
Microsoft Word 2003 document 
This Guide describes how to use the Equation Editor within Word to create 
equations. Familiarity with the basic editing operations in Word is assumed. 
There is a brief discussion of other ways of putting equations into a 
document. 
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Conventions: 
In this document, the following conventions are used: 
• A typewriter font is used for what you see on the screen. 
• A bold typewriter font is used to represent the actual characters you type at 

the keyboard. 
• A slanted typewriter font is used for items such as filenames which you should 

replace with particular instances. 
• A bold font is used to indicate named keys on the keyboard, for example, 

Esc and Enter, represent the keys marked Esc and Enter, respectively. 
• A bold font is also used where a technical term or command name is used in 

the text. 
• Where two keys are separated by a forward slash (as in Ctrl/B, for example), 

press and hold down the first key (Ctrl), tap the second (B), and then release 
the first key. 
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1 Introduction 
Several ways of putting equations into a document are described in this 
Guide. You should make sure that you use the method that is most 
appropriate for your situation. 

If you are about to produce a document, such as a scientific thesis, 
containing a large number of equations to be typeset to a high standard, 
you should consider using  

• LATEX — see section 1.1 
• MathType with Word — see section 1.2 

If you want to produce a Word document with just a few equations in it, and 
do not wish to use MathType, there are several ways to proceed: 

• Anyone who is already a competent user of TEX or LATEX could use 
that software to create an equation and then put it into their Word 
document — see section 1.1. 

• If you are familiar with the symbolic mathematics package Maple, you 
could consider using that to display your equations before importing 
them into Word — see section 1.3. 

• The Equation Editor provided with Word could be used — see section 
2 onwards. 

You may like to consult your department for guidance. 

The following equations will be used to compare the results of the various 
approaches. They are produced here using the Equation Editor: 
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1.1 LATEX  (or TEX) 
LATEX and TEX are typesetting tools that are widely used for producing 
scientific documents. To get more information about this software: 

Use a browser to access http://www.dur.ac.uk/its/software 

2 In the box under Search, enter latex 

3 Click the Search button.  

4 Click on latex. 
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5 Under Further information: follow the link to ITS pages relevant to 
latex. 

If you already have a file such as myeqns.tex (containing text and 
equations) it is possible to put one or more of the equations into a Word 
document should you wish to do so. The procedure is outlined below. 

The first step is to produce picture files of your equations.  

1 At a UNIX prompt, type 

setenv DENSITY 300 

This will give you a higher resolution than the default and produce a better 
quality picture of your equation. You can choose a setting other than 300 
dots per inch if you wish. 

2 Then type 

latex2html   myeqns.tex 

A directory called myeqns will be created containing a myeqns.htm file 
and lots of .gif files (one for each equation — img1.gif, img2.gif, …). 

3 If you are using a stand-alone PC, copy these gif files from UNIX to 
your PC. 

4 In your Word document, position the cursor where an equation is to 
be inserted. 

5 Select Insert | Picture |From File. 

6 In the Insert Picture dialog box, navigate to where your gif files are 
stored. 

If you select a gif file you will see a preview of the picture. This will help you 
to locate the correct equation. 

7 Select the picture you want and click the Insert button. 

The picture of your equation as it appears in your document may well be 
larger than you require. In that case, click on the picture to select it and 
drag a corner to re-size the equation. If it appears to be somewhat faint, 
don’t worry, it should print all right. 

Here are a couple of examples; you can compare them with the equations 
produced using the Equation Editor in the Introduction (section 1).  
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Note: If you want to re-run latex2html with the same TEX file you should 
first remove all the files it produced the last time.  

If you would like more information about latex2html, see InfoSheet 130: 
Using latex2html. 

1.2 MathType 
MathType is a mathematical equation editor for personal computers. It can 
generate high-quality mathematical notation for a variety of purposes 
including word processing and presentations.  

It is very easy to use and has many more symbols and templates than the 
Equation Editor. MathType automatically re-sizes square root signs and 
parentheses to fit their contents, inserts suitably-sized spaces around 
operators and relational symbols, and displays standard abbreviations in an 
appropriate style. 

MathType has been installed on the ITS Networked PC service. Guide 143: 
Using MathType is available from the IT Service Desk and the ITS Web 
pages. 

The sample equations are produced here using MathType: 
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1.3 Maple to Word 
If you use the symbolic mathematics package Maple, you can use that to 
display mathematical expressions and then import them into Word.  

For single expressions, the easiest way to do this is to cut and paste each 
expression from Maple into Word: 

1 Run Maple on a PC. 

2 Display the expression in Maple. 

3 Highlight the whole expression using the mouse. 

4 From the Edit menu, select Copy. 

5 In Word, position the cursor where the expression should be 
inserted. 

6 Paste the expression directly into your text. 
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Here are the two examples: 
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For larger blocks of mathematical expressions, export an entire Maple 
worksheet in Rich Text Format (RTF). 

From within Maple: 

1 From the File menu, select Export As and choose RTF. 

2 Enter a name for the RTF file and save it. 

Then, in your Word document: 

3 Position the cursor where the equations should be inserted. 

4 From the Insert menu, select File….  

5 Set the file type to RTF and navigate to the directory where you 
saved the RTF file. 

6 Select the RTF file and click on the OK button. 

The Maple command lines will be included in the RTF file. Once you have 
inserted the file into Word, these lines can be removed one by one if you do 
not want to include them. The display-maths expressions should look 
exactly like the ones shown above. 

There is more information about Maple in ITS Guide 65: Basic Maple. 

2 Configuring Word 
The rest of this document is about using the Equation Editor in Word. 

Before you start working through the various sections, you should check a 
couple of settings in Word. 

1 Activate Word (if you have not already done so). 

2 Select Tools | Options. 

3 Click on the View tab. 

4 Make sure that the boxes next to Picture placeholders and Field 
codes are both clear. (If there is a tick, click on it.) 
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5 Click on OK. 

3 Starting the Equation Editor 
As an example, instructions will be given for creating the following equation: 
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The first step is to open the Equation Editor, making sure that the insertion 
point is at the position in your document where you want the equation to 
appear. 

1 Open a new document — if you do not already have one on the 
screen. 

2 Select Insert | Object… from the menu bar. 

3 Make sure that the Create New tab is selected. 

4 In the Object type: window, select Microsoft Equation 3.0. 

5 Click on OK. 

 

Important: In Word 2003 on NPCS, this actually starts up the complete 
MathType package. For further details about this, please see ITS Guide 
143: Using Mathtype. 
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Note: The following text refers more to earlier versions of Word, and PCs 
which do not have MathType installed on them, but almost all of the 
principles are the same in Word 2003 on NPCS. 

 

Take care not to click outside the highlighted box — i.e. within the 
document. This will close the Equation Editor and return you to the 
document with the equation inserted — or a blank area if you have not yet 
created any equation. If you do this by accident, either click on the equation 
and then choose the command  Edit | Equation Object | Edit, or simply 
double-click on the equation. 

4 The Toolbar 
Each button on the Toolbar opens up a menu of items to select. 

The buttons on the top row are Symbols — groups of related mathematical 
symbols such as operators and Greek letters. 

The buttons on the bottom row are the Templates. A template is a 
formatted collection of symbols and empty slots. 

Equations and expressions are created by inserting templates and then 
filling in their slots with numbers, letters or symbols. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Relational Symbols 
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Spaces and Ellipses 

Embellishments 

Operators 

Arrows

Set Theory 

Miscellaneous Symbols 

Greek characters 

Matrices 

Products and Set Theory 

Labelled arrows 

Integrals

Overbars and Underbars 

Summation 

Subscript and Superscript 

Fractions and Radicals 

ts 

Logical 

Bracke



5 Building the equation 
The small dotted box with the flashing insertion point is an empty slot, 
where you will begin to build the equation.  

1 Type 

x= 

Do not put a space in-between — the editor will take care of that. 

 

It is possible to build the equation in any order. For this example insert the 
fraction (the horizontal line) next. 

2 Click on the Fraction and radical templates button. 

A menu of options appears. 

 

3 Click on the full-size vertical fraction template (top left). 

The equation now looks like this. 

 

The insertion point is in the upper slot of the fraction. You can now build 
this part of the equation. 

4 Type (with no spaces) 

-b 
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5 Click on the Operator symbols button (top row, fourth from left). 

 

6 Click on the plus or minus symbol, ±, (top left). 

The symbol is inserted into the equation. 

 

The next step is to insert the square root symbol. 

7 Click on the Fraction and radical button. 

8 Click on the square root template. 

The equation now looks like this 

 

Now insert the next part of the equation. 

9 Type 

b 

The next step is to insert the superscript of b2. 

10 Click on the Subscript and superscript templates button (bottom 
row, third from left). 

11 Click on the single superscript template (top left). 
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12 Type 

2 

 

The next step is to add –4ac to the upper fraction. Notice that the insertion 
point is still positioned after the superscript 2. If you typed in –4ac now, it 
would appear as part of the superscript like this: b2-4ac. This is incorrect for 
the equation you want. 

The insertion point must be moved out of the superscript first. 

13 Press the Tab key. 

Notice that the insertion point is now larger. 

14 Type 

-4ac 

 

The upper part of the equation is now complete. 

To complete the lower part of the fraction, you must position the insertion 
point in the empty slot under the line. 

15 Click in the empty slot or use the arrow keys to position the insertion 
point (make sure that it is within the slot). 

16 Type 

2a 

The equation is now complete. 
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6 Inserting the equation into your document 

1 Click anywhere in the document outside the equation box. 

You will be returned to the document with the finished equation in place. 

2 Click away from the equation to de-select it. 

You can use Cut, Copy and Paste with the equation as you would with 
normal text. Simply click anywhere on the equation to select it. 

6.1 Editing an inserted equation 
If you decide, after inserting an equation into a document, that you want to 
amend it, either click on the equation and then choose the command Edit | 
Equation Object | Edit, or simply double-click on the equation. The 
Equation Editor box containing your equation and the Equation toolbar will 
appear. Edit the equation as you wish and insert it into your document as 
before. 

If you are building a large, complicated equation you may wish to keep 
inserting the equation into the document and saving the document. You can 
then return to the equation by double-clicking on it and continue to build it. 

6.2 Resizing an equation 
Because the equation has been inserted as an Object you can control its 
size in the document. 

1 Click anywhere on the equation. 

A box appears around the equation. It has eight small squares around it, 
known as sizing handles. 

 

2 Position the pointer on the sizing handle at the bottom right-hand 
corner of the box. 

Guide 31: Putting equations into a Microsoft Word 2003 document 10



The pointer changes to a double headed arrow. 

3 Click and drag the mouse down and right, enlarging the box to about 
twice its original size. 

4 Release the mouse button. 

The equation should now be roughly double in size. 

 

For more exact sizing use the Format | Object command from the menu 
bar. Click on the Size tab and enter exact percentage figures in the scaling 
boxes. 

You can also change the font style and size of elements of the equation 
from within Equation Editor. Consult the on-line Help in Equation Editor for 
details. 

7 More on building an equation 

7.1 Enlarging the Equation Editor 
You may find it easier to work in the equation editor if you use the View | 
Zoom command in the document window to set the zoom to 200% before 
starting the Equation Editor. This does not affect the printed size of the 
equation. A 400% zoom is particularly useful when making fine adjustments 
to the spacing of items (nudging). 

7.2 Equation order 
You don’t have to create an equation in a particular order. For example you 
can create the numerator (top) of a fraction first. When you want to create 
the fraction, select the numerator and click the Fraction and radical 
template. The selected expression (numerator) appears in the top slot and 
there is a blank slot ready for the denominator. 

7.3 Moving around an equation 
You can move between the elements in an equation by clicking with the 
mouse or using the arrow keys. Pressing the Tab key will move the 
insertion point to the next slot in the equation. Press Shift and Tab to move 
to the previous slot. 
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7.4 Selecting equation items 
You select most equation items just as you do in other Windows 
applications. There are however additional methods for selecting slots, 
matrices and the symbols inserted as part of templates, such as character 
embellishments and summation signs. These are summarised below. 

To select Do this 

An area of an equation Click the starting point and drag over the area.  

A symbol that is part of 
a template 
e.g. ( )  

Hold down the Ctrl key. When the pointer 
changes to an outline arrow, click on the 
symbol. 

A template (symbols 
and slot contents) 

Position the insertion point to the left of the 
template and press the Delete key. 

A slot’s contents Double-click anywhere in the slot. 

A matrix Drag over the expressions in the matrix. 

An entire equation Choose Edit | Select All from the menu or 
double-click anywhere within the outermost 
slot. 

7.5 Deleting equation items 
Characters and symbols can be deleted by using the backspace and Delete 
keys as with ordinary text.  

To delete the contents of a slot select the contents first and then press the 
Delete key. 

Empty slots can sometimes be deleted by selecting them and using the 
Edit | Clear command. Some slots however cannot be deleted without also 
deleting the template that contains them. For example, you can’t delete the 
integrand slot from an integral.  

To delete a template, select it and all its slots and press the Delete key. 

A selection can be deleted by: 

• pressing the Delete key 
• choosing Clear from the Edit menu 
• typing something which will replace the selected area 

If you need to undo a deletion, immediately select Undo Typing from the 
Edit menu. 

7.6 Entering text in an equation 
By default the Equation Editor applies an italic font to text. You may, 
however, want to include plain text within an equation, as in 



| |x x n Nn − < ≥0 ε  for all  

This is done by using the Text style mode. 

To enter text in an equation: 

1 Select Style | Text from the menu bar. 

2 Type in the text. 

3 Select Style | Math to return to the usual Math style mode. 

You can use the spacebar when in Text style. Other styles — Function, 
Variable, Greek, and Matrix-Vector — are also available. 

8 Alignment and spacing 
The Equation Editor automatically applies spacing and alignment to the 
equation. You can change these in several ways: 

• The Spaces and Ellipses symbols include blank spaces that can be 
inserted into an equation. The View | Show All command from the 
menu bar will display any space symbols that have been inserted this 
way. 

• You can make fine adjustments by moving elements. This is known 
as nudging. Select the element you want to adjust and then press an 
arrow key while holding down the Ctrl key.  
Special symbols can be created by moving one character on top of 
another. 

• You can also control the default spacing used by the Equation Editor 
(select Format | Spacing). Consult the online Help in Equation Editor 
for details. 

8.1 Redrawing an equation 
If you have repositioned elements of an equation there may be small parts 
of symbols left displayed. You can redraw the equation by choosing the 
command View | Redraw. This will “clean up” the display. 

8.2 Aligning a pile of equations 
If you have several equations that are displayed on consecutive lines you 
can align them by using the Format | Align commands. 

1 Enter all the equations, pressing Enter to move to each new line. 

2 Click anywhere within the equations. 

3 Select Format. 

4 Select the required alignment. (Choose Align at = to line up all the 
equations at the = sign.) 
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An alternative method is to insert an alignment symbol into each equation 
at the appropriate place. You can find this symbol in the top left position of 
the Spaces and ellipses menu — it looks like a vertical line of dots with a 
triangle at the bottom. The Editor will automatically line up the symbols on 
each line. The alignment symbols will not show in the printed document. 

8.3 Numbering equations 
If some equations in your Word document are to be numbered, it is 
probably best not to use the Equation Editor to produce the equation 
numbers. Instead, just type the numbers into your Word document. 

For an attractive layout, you could position your equation in the middle of 
the page using a centre-aligned tab. Then position its equation number 
near the document’s right (or left) margin using a right (or left) aligned tab. 

9 Shortcut keys 
When working on a large equation you may find it more convenient to use 
the keyboard to apply commands. Shortcut keys are especially useful for 
commonly repeated actions. A full list of the shortcut keys can be found in 
Help from within the Equation Editor.  

1 Select Help | Equation Editor Help Topics. 

2 With the Contents tab selected, double- click on Reference 
Information. 

3 Double-click on Keyboard Guide.  

Pages can be printed out for easy reference (click on the Options button). 
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